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New functions in V4.6 1
 

Overview 
New functions in V04.06.00.00:  
● PLC timeout trigger 
● Revision of time trigger/IHP/IHA 
● Expansion of e-mail notification by company, location, production unit 
● Variable monitor 
● Expansion of equability test - Characteristics Linear trend with limit values 
● Run contour test in single block 
● Equability test limit values for vertical axes separately for each direction of motion 
● Export of axis test data, measurement series, monitors for graphic processing 
● Prolog program causes the pending measurement series to be skipped 

1.1 Timeout trigger (FEAT 244.1.14.10) 

Status 
The user of ePS Network Services can trigger on all signals of the control, that change a 
signal state or have a defined state. 

Problem 
There are signals in mechanical engineering, that have and must have regular status 
changes in definable cycles. Currently, ePS Network Services cannot be used to monitor 
these signals in order to trigger a specific action within a freely definable time in case one of 
these signals is not output. 
The user should not be supposed to program a logic in the control to convert regular clock 
signals into such trigger signals, since remote setting of this feature would not be easy. 
A motion that is recognized as started via the falling edge of a limit switch and a rising edge 
of another limit switch has a timeout that has to be monitored and recognized without 
intervention in the PLC. 
A motion that is recognized cyclically with an edge of a limit switch has a timeout that has to 
be recognized without intervention in the PLC.  
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Requirement  
A trigger for regular clock edges of identical and different PLC signals, that can be used to 
configure a time interval for the defined edges of the signals, is required.  

Approach 
A trigger is configured that defines two control variables in bool or byte, word. A boolean bit 
is evaluated for a 0-1 and 1-0 edge change, a byte and word is evaluated for a change of its 
value to restart the time interval between the two signals that can be configured in the 
trigger. The trigger trips when the time interval, that has a configurable length, times out.  

 

1.2 Time trigger for maintenance jobs (FEAT 244.6.1.3) 

Status 
The user of ePS Network Services can carry out maintenance plannings via the 
maintenance plan and via control monitors. 
Maintenance planning via the maintenance plan itself is possible only via time control and 
cannot be completed with all available actions. 
Maintenance planning can be controlled via control monitors. Although actions for linking are 
available, the time control is limited. 

Problem  
The user of the maintenance planning cannot map the maintenance and service specified for 
a machine completely in ePS Network Services. He will always require a second system for 
maintenance management, which then puts the use of ePS Network Services generally in 
question. 
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Requirement  
● Maintenance plans, which are stored in the system even without control mechanisms. 
● Grouping of maintenance plans, in order to plan maintenance packages. 
● Time control with calendar function and individual maintenance time frames, such as 

weekends, vacations, public holidays. 

Approach  
Maintenance plans are implemented in actions by control monitors. The time trigger is 
expanded by calendar functions and markable maintenance time frames.  
The calendar functions can be defined across machines for user-configurable machine 
groups. 

 

 Note 
Expansion of the time trigger 
For all interval types a revision was made (minutes, hours, days, weeks, months). In 
addition, the item "Last execution" was transferred from the maintenance plans to the time 
trigger.  

 

Direct configuration of the time interval has been removed from the maintenance plans.  
Everything dealing with the time interval has been removed from the maintenance plans. 
Also for this reason, the time trigger has been made more user-friendly to ensure that 
maintenance intervals can be better mapped in the future. The decisive change here is that 
the machines using maintenance plans must always be connected, since the time 
component is handled via the time trigger (client trigger). 
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1.3 E-mails with machine master data (FEAT 244.6.2.5) 

Status 
The user receives e-mail notifications containing the machine ID, the time of the event that 
caused the notification and the details of the event.  

Problem 
From the e-mail, the recipient cannot directly determine which machine is affected, where (at 
which customer) it is in use and under which machine number it is listed. The search for the 
machine via a WWS is not only laborious, but partly even possible without the support of a 
third party authorized to operate the WWS. 

Requirement  
A selection must be provided that enables the user to make a setting that the machine 
master data is to be included in the e-mail notifications. 

Approach 
When configuring a machine, the user shall be able to select whether e-mail notifications are 
to include complete information for identification or only the machine ID. 
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1.4 Variable monitor UCS491 (FEAT 268.2.1.1) 

Problem 
In general, NC monitors and PLC monitors in the current system are monitors that record 
variables from the control system - in one case from the NC and in the other case from the 
PLC - via a trigger (usually a cyclical time trigger). 
The concepts of the two functions have hardly any differences, but they have been 
implemented completely separate from each other and differently. 
The NC monitors have been implemented approximately one year before the PLC monitors. 
NC and PLC monitors differ in the operator control options of the display, as well as in the 
configuration and the integration in the control monitors.  
Since the two functions are not based on a common implementation, changes that are to be 
implemented for NC and PLC monitors are to be carried out always at two points.  
The current NC monitors provide the option to select from a list of available counter 
variables. As the user cannot be expected to accept a step back in user-friendliness (the 
variable monitors do not offer a selection of the variable), the current NC monitors will be 
retained in addition to the new variable monitors for the time being. 
In the first stage, the system will not offer an option to select variables to be recorded from a 
list of available variables when configuring a variable monitor. 
Variable monitors will replace the current PLC monitors. The data acquired previously via 
PLC monitors must be transferred into the variable monitors. 
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1.5 Characteristic Linear trend (FEAT 268.1.1.6.1) 

Problem 
The torque characteristic of the equability test often exhibits a curved baseline. This baseline 
often occurs in the case of axes with counterweight. The baseline prevents other 
disturbances (peaks, jumps, oscillations, ... ) from being monitored via the statistical 
characteristics of the equability test (min, max, ... ). 
The baseline can be direction-dependent. 
● Extract the signal proportion of the baseline from the torque characteristic. 
● Quantify the curve of the baseline (linearly, in the first approximation), so that the 

baseline can be monitored via limit values. 
● Correct the torque characteristic with regard to the baseline and calculate the statistical 

characteristics (min, max, ... ) on the basis of the corrected torque characteristic. 

Approach 
Development of a method, which determines a linear trend in the raw data of an equability 
test. Initial analyses have shown that a method using the minimization of the error squares of 
the individual measuring points is not sufficient, as outliers in the equability test are 
overproportionately taken into account. 
The system presents the user the linear trend in the form of new characteristics: 
● Trend gradient (gradient of the straight line) with configurable limit values 
● Trend offset (offset of the straight line) possibly as a substitute for the current average of 

torque/force 
The already defined characteristics min torque, max torque as well as standard deviation of 
the torque are only calculated and stored from the corrected data.  
The new characteristic must be included in the field of Reporting for the organization DC 
OM651 as well as handled in the Control Monitoring event history.  
The conversion of the old equability test characteristics via a business converter run is 
required after the introduction of the linear trend. 
A conversion must also be carried out for a conversion of a machine from V3 to V4.  
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1.6 Executing contour test in single block (FEAT ...) 

Problem 
In order to test the prolog/epilog program, the operator might like to go through the program 
during a contour test in single block. However, at the current stage of implementation, this 
results in the contour test being aborted.  

Approach 
The contour test is supposed to execute the prolog program and, if possible, also the 
measuring program in the single block, without any additional configuration. 

1.7 Separation of the equability test limit values for vertical axes 
(FEAT 268.1.1.10 ) 

Problem 
For vertical axes, the torque values for the two directions have strongly different values. 
Currently, the limit values can be defined only jointly for both directions. Monitoring of the 
torque values with limit values is therefore hardly possible for vertical axes. 

Approach 
The configuration of the equability test needs to be extended in such a way, that a warning 
and critical limit can be configured for each torque characteristic per direction of motion.  
On the user interface, the possibility of switching between joint/separate display will be 
offered in the measurement series configuration. If no motion-specific limit values have been 
configured, joint display is used at the beginning.  
When switching from direction-specific limit values to common limit values, a corresponding 
confirmation prompt is displayed: provided that different limits have been defined for the 
individual directions.  
The display of the characteristic curve within the configuration is depending on the currently 
selected display type and the selected limit values.  
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1.8 Skipping measurement series in the prolog (FEAT 268.1.2.18 ) 

Problem 
The intention is to selectively skip the execution of a pending measurement series via the 
prolog/epilog program and to ensure that the axis movements are not executed. However, 
this is not supposed to result in the cancellation of the test series. 
Concrete case: Machine has two pallets, an axis is installed on pallet 1. Therefore, the B axis 
may only be moved in the range of +/- 100°. This must be recognized in the prolog and the 
motion must be canceled if the limited traversing range is violated. 

Approach 
The prolog/epilog - called in the context of the measurement series - signals via a return 
value that the measurement series must not be executed. Thereupon, the measurement 
movement is not executed. 
In a test series, the affected measurement series is marked in the log as not executed and 
the next measurement series is then carried out. 
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Information from Function Manual V04.06: 
Description of the return parameters  
You can influence the measurement via the return parameters. The return values are always 
queried after call with doProlog = True and testType = "  ", i.e. after the prolog is called for 
each measurement series. The process then continues according to the returned values. 
 
Parameter Equability test Circularity test Universal axis test 
ePS_error 0 =  Carry out the measurement (default setting) 
 1 =  Suppress the measurement, continue with the next measurement 

series, no error display.  
ePS_errMsg Reserved for future expansions 

 

Example from prolog - epilog 
 
  
  

  IF (testType == "EQUABILITY") ;actions for all equability tests, e.g. approaching 
the start position 

    IF (axParam1 == C) AND (realParam1 > 300) ; example of using the return parameter ePS_error 

    ePS_error = 1 ;the equability test with the C axis is to be skipped

    ENDIF  

    IF (measSeriesName == "") ; specific actions for single series of measurements 

    ENDIF  

  ENDIF  
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1.9 Export of axis test data, measurement series, monitors for graphic 
processing (FEAT 268.1.2.20) 

Example: Individual measurement  
 
< Position X1 < Torque (pos.) < Position X1 < Torque (neg.) 

2.800.897 0.0502738235317234 7.139.076 0.0555297292997933 
28.21 0.123327386960531 71.19 0.156524871156256 

2.840.917 0.1233280454801728 7.099.037 0.15652004035732 
28.609 0.146433698496593 70.791 0.134515215850062 

2.840.946 0.146487110051778 7.059.017 0.134510356012611 
29.009 0.0855402764776069 70.391 0.685055363451055 

2.840.913 0.0855936001029577 7.019.071 0.685006895749862 
29.409 0.686468544586208 69.99 0.0904958326413868 

2.840.877 0.687000821667887 6.979.075 0.0904910110379804 
29.809 0.165753432439635 69.591 0.164486177335193 

3.000.921 0.165806777383582 6.939.031 0.164481320885569 

 

Example: Measurement series  
CHANNEL1_GLT_X1 
 
Thursday, 22 March 2007 Torque ∅ ->  
22.03.2007, 09:25 0.113336407318923 
22.03.2007, 09:30 0.111383370463259 
22.03.2007, 09:58 0.105939891958589 
22.03.2007, 10:06 0.11343074010751 
22.03.2007, 10:09 0.106269508056534 
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1.10 Changes in the system behavior 

Modified system behavior V04.06.00.00 SL14  
Here, the changes in the system behavior compared to the latest released version 
V04.05.03.00 are described: 

Variable monitors replace the PLC monitors 
In V04.06.00.00, the new variable monitors replace the previous PLC monitors. The previous 
menu item under "Configure functions" changes from PLC monitor to variable monitors. The 
configuration of the monitors changes accordingly.  
For further information, please refer to the Function Manual for V04.06.00.00.  

 

Display of the PLC monitors 
PLC monitors can display other values than the newly calculated variable monitors. Under 
certain circumstances, PLC monitors had an incorrect compensation; this has been 
remedied in V04.06 with the variable monitors.  
After installation of the V04.06.00.00 system in the productive environment of the ePS 
Network Services, both variants - the PLC monitor and the converted variable monitor - will 
be visible and usable in the system until the end of the conversion (several days). A 
difference between the values might be recognizable with a direct comparison of the 
monitors.  
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Ramp recognition of the equabiltiy axis tests - Incomplete representation of the graphics  
Up to V04.06.00.00, it is possible that for some measurements the "braking ramp" is missing 
in certain circumstances, since we record only a restricted number of measuring points with 
the TraceServer or ServoTrace. The calculation of the recording time can only represent an 
estimate. It is thus possible in some cases that the braking ramp is truncated. 
The procedure for calculating the area with constant velocity takes samples and attempts to 
determine the permissible velocity deviation; at some positions the velocity may lie outside of 
the calculated tolerance range, which leads to a truncation of this range. This is normal with 
specific velocity profiles of the equability test in combination with the calculation method. 
V04.06 contains a more robust method for the calculation of the stationary state, which can 
also handle rather strong fluctuations in the velocity characteristic. 
During a conversion to the V04.06.00.00 system, all existing measurements are also 
recalculated; this can lead to different (improved) representations compared to the previous 
server version.  
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New errors in V4.6 2
2.1 NC monitors with the same name cannot be copied correctly 

(CQ13083) 

Error description 
Several existing NC monitors with identical names are copied only once when executing 
"Copy function settings".  

Remedy 
Change the designation of the NC monitors before copying, i.e. assign a unique name for 
each NC monitor.  

2.2 Entered limit values of a variable monitor cannot be deleted 
(CQ12742) 

Error description 
A variable monitor has been saved with limit values. The limit values are deleted and, at the 
same time, the limit is inactived. If you now save and open the variable monitor, the limit 
values are still available. 

Remedy 
Delete the limit values and save the variable monitor, and only then switch the variable 
monitor inactive. 
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2.3 In the equability test, the display of the P/I component is 0 (CQ12501) 

Error description 
If an equability test is carried out on a SINUMERIK 840D sl control, 0 is displayed for the 
supplementary conditions of Gain P component and Gain I component, although entries 
have been made at the control.  
This occurs only if HMI Advanced and an ePS Client powerline are used.  
If HMI sl and ePS Client solution line are used, the parameters are read out correctly. 

Remedy 
Use ePS Client powerline version V04.03.03 and higher. 

2.4 During a dump, the machine remains in the status "Transfer is active" 
(CQ12426) 

Error description 
Sporadically, the transfer remains in the status "Transfer is active". 
The problem occurs primarily during a transfer from a very slow eP satellite to the ePS 
server. 

Remedy  
Repeat the transfer.  
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Common errors 3
3.1 Manual import of offline data (CQ11764) not possible. 

Error description 
The manual import of offline data does not work if more than one archive file was generated.  

Remedy 
Use the function "Import directory" under "Statistics / export" for more files.  

3.2 Diagnostics actions are not executed (CQ10275) 

Error description 
If a control monitor is configured with at least one mailing action by email, and the option 
"Generate incident input" has been switched off, only actions of the type "PLC monitor" are 
executed as a diagnostics action when a trigger occurs. 
All other actions such as notifications by email / SMS, uploading of files (NC, HMI action 
logs, PLC moduls, PLC Trace...) are not executed. 

Remedy 
Switch on option "Generate incident":  
All configured actions will then be executed correctly, but an incident input will be generated 
in the incident history when a control monitor occurs.  

3.3 Error message "Recorder parameter error" when executing a 
measurement (CQ10303) 

Error description 
A message is cancelled with the error message "Recorder parameter error" when no axis is 
defined for index 0 of the axis assignment of the measured channel. 

Remedy 
Do not configure a leading axis gap (index 0) in a channel.  
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3.4 Error after closing a teleservice session with Internet Explorer V7 
(CQ9999) 

Error description 
When a teleservice session is set up with Internet Explorer 7 and then closed to return to the 
ePS page, the browser is closed with an error message. 

Remedy 
-- 

3.5 Channel switchover no longer works in 1:N operation when ePS is 
installed (CQ8149) 

Error description 
The channel switchover function of HMI Advanced no longer works if the entry MMC_TYPE 
= 0x20 is set in the NETNAMES.INI on machines in a 1:N / M:N network and the ePS 
Network Services are installed. It is not possible to operate the ePS Network Services either. 

Remedy 
The entry in the NETNAMES.INI must be changed to MMC_TYPE = 0x40. 

3.6 Measurement does not start in ShopMill/ShopTurn Version 6 
(CQ7777) 

Error description 
On a machine with ShopMill/ShopTurn installed, an active measurement (EAT, CT, UAT) 
stops before the "Please press NC Start" box is displayed. The ShopMill/ShopTurn machine 
does not switch to "Auto" mode, but the measurement sequence requires the machine to 
switch over. The measurement sequence is therefore interrupted at this point. 

Remedy 
A file "eps.ini" with the following entries can be created: 
 [NCStart] 
 PossibleWithJog = 1 
The file must be saved in one of the following directories: \add_on, \oem oder \user. 
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3.7 A V3 machine in a V4 organization cannot be reconnected (CQ7408) 

Error description 
If the connection of a V3 machine in a V4 organization is canceled indirectly, e.g. as a result 
of reinstallation of the ePS client,  it is not possible to reconnect this machine with the 
previously registered V3 database machine. 
The control displays only unconnected machines for selection as machines to connect. 
However, in this instance, the V3 machine is still registered in the database as connected. It 
is not possible to disconnect the machine on the service PC as this does not support 
disconnection of V3 machines. 

Remedy 
Create a new, temporary V3 machine on the PC and connect it to the control. The V3 
interface is now displayed on the control and the previous V3 machine can now be re-
registered.  
The temporary V3 machine can be deleted again on the service PC afterwards. 

3.8 It is not possible to edit the epilog/prolog with the UP and DOWN 
cursor keys on the operator panel (CQ6397) 

Error description 
The UP and DOWN cursor keys cannot be used to navigate around the epilog/prolog when 
this is being edited on the operator panel. 

Remedy 
Navigate using key combination <CTRL> + cursor key UP or DOWN. 

3.9 Chinese Tooltips are not displayed correctly (CQ5362) 

Error description 
Tooltips are not correctly displayed in the Chinese language. Squares appear in place of the 
Chinese characters. 

Remedy 
Install the Chinese version of Windows on the PC, or install the Windows XP MUI Service 
Pack for Chinese Simplified. 



Common errors  
3.10 Incorrect results for UAT with modulo rotary axes (CQ5125) 

 Release Notes 
24 Readme, 08/2008, -- 

3.10 Incorrect results for UAT with modulo rotary axes (CQ5125) 

Error description 
When a universal axis test is performed with a modulo rotary axis and the start position is too 
close to 360 degrees (e.g. the movements exceed the 360-degree threshold in each case), 
the UAT characteristic value calculations are incorrect. The coherence is very low in this 
case. 

Remedy 
– 

3.11 No focus on IAC on the HMI following a measurement (CQ5029) 

Error description 
On completion of a measurement, it is sometimes impossible to make inputs on the HMI 
(e.g. change status). This error occurs sporadically and is caused by the IAC losing the 
focus. 

Remedy 
Change to the "Machine" main screen and back to ePS again. The ePS can then again be 
operated with the softkeys. 

3.12 Error message "You have not activated any cookies" (CQ4868) 

Error description 
If the setting for "Check for newer versions of stored pages" in the Internet Explorer is set to 
"Never", the error message "You have not activated any cookies" appears when you call the 
ePS Network Services. 

Remedy 
Change the Internet Explorer setting from "Never" to "Automatically":  
"Tools" → "Internet Options" → "Temporary Internet Files" → "Settings" → "Check for Newer 
Versions of Stored Pages". 
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 3.13 UAT cannot be performed for simulated axes (CQ4653) 
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3.13 UAT cannot be performed for simulated axes (CQ4653) 

Error description 
The universal axis test (UAT) with simulated axes is terminated with the error message 
"Unable to evaluate data". The test is not stored. 

Remedy 
–  

3.14 Automatic installation via D:\Install does not work (CQ4566) 

Error description 
The option of installing the ePS Network Services automatically by copying the setup.exe to 
D:\Install on a PCU does not work. The installation is aborted with the following error 
message as the PCU boots:  

 

To correct or avoid errors 
If Internet Explorer 5.5 is already installed on the PCU, the error does not occur and the ePS 
Network Services are installed correctly.  

3.15 TRANSLINE interface fails to start on an S7 control (CQ4541) 

Error description 
The TRANSLINE interface fails to start after the ePS Network Services have been installed 
on an S7 with TRANSLINE interface. This error occurs only if the ePS Network Services 
have been installed with option SINUMERIK 840D (default) instead of option S7 on an S7 
controller. 

Remedy 
Install the ePS Network Services again and select the correct option. 



Common errors  
3.16 System information is not displayed (CQ4325) 
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3.16 System information is not displayed (CQ4325) 

Error description 
No system information is displayed for an S7 controller with HMI Base. 

Remedy 
System information can be displayed only for S7 controllers with HMI Advanced. 

3.17 Test SMS is sent more than once (CQ2667) 

Error description 
If a test SMS is sent when an entry is set up or edited in the address book, and the page is 
then refreshed (key <F5> or "Refresh"), then the page is loaded again and another test SMS 
is sent. 

Remedy 
–  

3.18 Exporting a PLC data block does not work (CQ2458) 

Error description 
When a PLC data block is exported, the Download dialog does not appear, but the content of 
the file is displayed in the browser window instead. The error occurs if the file contains only 
valid ASCII characters. 

Remedy 
Select "File" → "Save As..." and store the displayed file as a *.bin file on your PC. You must 
then click the "Back" button in the browser to return to the ePS Network Services. 
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 3.19 Error message after registration of a machine is aborted (CQ1767) 
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3.19 Error message after registration of a machine is aborted (CQ1767) 

Error description 
If a machine registration process has been aborted, the error message "Inform failed" might 
be displayed in a dialog in a variety of situations when the machine is being operated.  

Remedy 
Please register the machine again. 



Common errors  
3.19 Error message after registration of a machine is aborted (CQ1767) 
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Corrected errors 4
4.1 Copied PLC Trace cannot be changed (CQ11978) 

Error description 
With a copied control monitor with diagnostics action PLC Trace, the recording time is to be 
changed. This leads to the error message "The two raw values of the scaling must not be 
equal". The diagnostics action can neither be changed nor saved. 

Remedy 
Input a valid scaling (e.g. 0=0; 1=1) and then save. 

4.2 Proxy authentification not possible in 1:N operation (CQ9177) 

Error description 
If a proxy with authentication is used, a 'BootScript not available' alarm is displayed on all 
active NCUs in 1:N operation, because the ePS client cannot authenticate to the proxy. The 
user name and password for authentication which are assigned via the ePS client setup 
routine are not stored at the correct location for the individual NCUs. 
Workaround: 
Open the following key in the registry (regedit): 
HKEY_LOCAL_MACHINE\SOFTWARE\ePS Network - electronic Production  
Services GmbH\ePS Network - Services V4.2.0\Configuration\MH  
Copy the "alice" and "bob" entries to the appropriate MH directory of the relevant NCU. The 
subdirectories are named according to the names of the NCUs. 

Remedy 
Use ePS Client powerline V04.04.03.00 and higher. 



Corrected errors  
4.3 Connection setup to the machine crashes (CQ7047) 
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4.3 Connection setup to the machine crashes (CQ7047) 

Error description 
On a machine with several NCUs, the setup of a connection to the machine stops without an 
error message if not all the connected NCUs are active. 

Remedy 
If an inactive NCU has been selected by HMI Advanced for ePS Network Services, then a 
message will be output that the machine cannot be connected. 
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